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Why use a HAT at all?

" Automates generation/compilation
" Browser-based output (WebHelp)

" Single-sourcing

" Tri-pane paradigm

" Context-sensitivity

" Indexing

" Other Help-specific features



Other possibilities

" Generic HTML-based authoring tool
" Generic XML-based authoring tool
= Wiki

" Blogging tool

" Notepad



Fora HAT

" Targeted towards user assistance
" “Off the shelf” solution

" Integrated one-stop solution for
multiple outputs

" Usually requires little or no
knowledge of underlying
technology

® Some tools offer controls for
Dynamic/Embedded Help



Against a HAT

®" Non-standard

" May lock you in to proprietary
technology

" Potentially less flexible

" Limited capability for content
management and re-use



The HAT candidates

" Adobe RoboHelp (also TCS3)
" Author-it

" ComponentOne Doc-To-Help
" EC Software Help & Manual

" MadCap Flare

" WebWorks ePublisher



Features most of the HATs have in common

" TOC /Index/FTS

" MS Help output

" Browser-based Help output (WebHelp)
" Map IDs for context-sensitive Help

" Conditional content

" Variables

" Snippets / embedded topics

" Resource sharing between projects
" DHTML drop-downs



Selection Criteria

" “In a nutshell” description
" Workflow

" Ul and usability
" Key strengths

" Key weaknesses
" Own Help



ADOBE ROBOHELP



RoboHelp in a nutshell

" Edit in XHTML using RoboHelp
WYSIWYG Editor

" Project settings stored in variety of
text files

" For single-sourcing print and Help:
- Create print document in Word

- Link Word doc to RoboHelp project
- Publish through RoboHelp to Help



RoboHelp workflow

==

Also:

* DITA

e FlashHelp

« JavaHelp

* Eclipse Help
« XML



TCS3

" Same as RoboHelp, except:
- Can link FrameMaker documents

- Therefore richer print capability for
single-sourcing



TCS3 workflow

==
==

Also:

* DITA

e FlashHelp

« JavaHelp

* Eclipse Help
« XML



RoboHelp Ul and usability
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RoboHelp Ul and usability

" Retains look-and-feel and key
principles from earlier versions

" Many Pods - customizable layout

" Editor formatting Ul looks like Word
(pre 2007)

" In my opinion: some problems with
Ul for importing/linking



RoboHelp key strengths

" Indexing and search

" WebHelp output

" AIRF

elp output

" New

Resource Manager

" Integration with Captivate

" Single-sourcing from Word
(and from FrameMaker in TCS3)



RoboHelp key weaknesses

" Print documentation output

" Lack of support for
importing/linking FrameMaker
documents (except within TCS3)

= Ul for importing/linking Word and
FrameMaker documents

" Very large footprint



RoboHelp’s own Help
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Using RoboHelp HTML 9
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Using RoboHelp HTML 9

. Getting started

- Exploring the workspace
- Projects

- Working with topics

- Editing and formatting

- Styles and style sheets

. TOCs, indexes, glossaries

- - -l H e

Popular resources

Support

Getting Started
and Tutorials

Forums




AUTHOR-IT



Author-it in a nutshell

" All content (for multiple projects)
stored in a single Library (database)

" Object-oriented

" Very powerful and flexible re-use
across multiple projects

" Permissions based on logon

® Can use SQL Server or free JET / SQL
Server Express database



Author-it workflow

FM
(MIF)

Database DITA
XML
HH
Also:

* Website
i e JavaHelp
SIS it » Oracle Help
(4

* WinHelp




Author-it Ul and usability
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Author-it Ul and usability

" Ribbon-based
" Multiple windows and components

" Granularity gives flexibility and
power, but increased complexity



Author-it key strengths

" Content management

Structured authoring (without requiring
knowledge of XML)

Role-based permissions
Object Variants
Authoring memory (requires Xtend)

Localization support
(requires Localization Manager)

" Project management
(requires Project Manager)

" Web-based authoring
(requires Author-it Live)



Author-it key weaknesses

" Proprietary storage format
" Uses Word for all print publishing

" No longer aimed specifically at Help
authoring

" Potentially over-complex for some
needs



Author-it's own Help
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COMPONENTONE DOC-TO-HELP



Doc-To-Help in a nutshell

" Edit in XHTML using Doc-To-Help
WYSIWYG Editor

" Alternatively, edit in Word or HTML
(using FrontPage or Dreamweaver)

" Add metadata and other special
features using D2HML

® Metadata also stored in an Access
database

D>




Doc-To-Help workflow

Word

HTM
-@ @

Called
NetHelp

MS Help 2

Also:
* WinHelp



Doc-To-Help

Ul and usability
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Pittsburgh Sites

Pittsburgh has many wonderful scenic and memorable places to visit. Here is a list of just a few of
them:

1. Allegheny Observatory
Riverview Park
Pittsburgh, PA 15214
412-321-2400

2. Carnegie Science Center
One Allegheny Avenue

Pittsburgh, PA 15212
412-237-3400
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1220 Grandview Avenue
Pittsburgh, PA 15211

412-381-1665

m

ED Documents
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.j_:" Contents
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@ Index and Groups

412-622-6914
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Related Topics
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Doc-To-Help Ul and usability

" Improvements in Ul from 2007
onwards

" Ribbon-based
" Powerful and flexible Topics tab

" Style sheet concepts can be
confusing

" Error messages rather opaque



Doc-To-Help key strengths

" Authoring support for Word,
FrontPage and Dreamweaver

" Automatic and customizable “topic
relationships”

" New NetHelp search engine

" Support for team authoring without
need for source control software

" SharePoint integration

" Support for documenting Class
Libraries with Microsoft Sandcastle



Doc-To-Help key weaknesses

" Relatively slow build process

" History of dependence on Word has
shaped the product

" Potential synchronization problems
between source docs and DTH
database



Doc-To-Help’s own Help

@ ComponentOne Doc-To-Help 2010
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@ Windows
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E Creating Inline, Dropdown, ar Popup Text
ﬂ Inserting an Index Entry
ﬂ Adding a Topic to a Group
ﬂ Adding a Link Tag
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2] Inserting a Variable
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; @ Employes Handbook.doc
o E.h"l Glossary.doc

__ﬁ Documents
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5 Related Topics

Doc-To-Help's navigation panes make it possible to quickly work with
your documents, table of contents, index, and related topics. Click on
the button to expand the pane and open the accompanying window.

See MNavigating Doc-To-Help for information on other navigation
methods.

More:

[0 Documents pane

[0 Contents pane

[ Index and Groups pane
[ Related Topics pane




ECSOFTWARE HELP & MANUAL



Help & Manual in a nutshell

" Edit in XML using Help & Manual
WYSIWYG Editor

" Project settings, styles, and
templates all stored in a single
project file in XML format

" For single-sourcing print and Help:

- Generate PDF and Help targets from
Help & Manual



Help & Manual workflow

HTML

* WinHelp



Help & Manual Ul and usability
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Help & Manual Ul and usability

® Ribbon-based

" Simple wel

" Authoring
structure

-organized Ul

orocess driven by TOC

" Styles and formatting heavily based
on Word paradigm

" Advanced features less exposed



Help & Manual key strengths

" Powerful “skins” for adding advanced
features and achieving consistency
across projects

" Support for modular Help

" Support for team authoring without
need for source control software

= Ability to share resources across
projects

® Built-in non-scrolling region support

" Support for documenting Class
Libraries with Microsoft Sandcastle



Help & Manual key weaknesses

" List formatting
" No FrameMaker import
" No DITA support



Help & Manual’s own Help
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MADCAP FLARE



Flare in a nutshell

" Edit in XHTML using Flare WYSIWYG
Editor

" Project settings all stored in XML
files
" For single-sourcing print and Help:

- Generate PDF and Help targets from
Flare



Flare workflow

==
==

==

WebHelp
Mobile

Also:

* DotNetHelp
* FrameMaker
* Word

e AIR



Flare Ul and usability
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Communicating with
students using audio

You can broadcast audio
messages or use audio for two-
way communication with
selected students. This only
works if the tutor computer and
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Flare Ul and usability

" Powerful, fairly complex and slightly
quirky workspace

" Many different editors for different
file types

" Users benefit from understanding of
CSS

" Unusually comprehensive and
excellent Help system



Flare key strengths

" WebHelp Mobile output
" Authoring memory (Intellisense)

" Automatic conversion of text to
variables (requires MadCap
Analyzer)

® Feedback and collaboration
(requires Feedback Server or
Feedback Service)

" Search filtering
" DotNetHelp format




Flare key weaknesses

" Limited keyboard shortcuts

" Some quirks in PDF output

" Not a true content management
system



Flare’s own Help
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You are here: Features > Projects > More About Projects > Deleting Projects

Deleting Projects

To delete a project completely, you must use Windows Explorer. This operation cannot be done from Flare.

You can also remove projects from displaying in the File=Recent Projects menu and the Start Page in Flare. This does not
delete the project, but simply removes it from those shortcut locations.

How to delete a project through Windows

1. In Windows Explorer, browse to the location where you have stored the project (e.g., C:\Documents and
settings\Projects\My Project).

2. Delete the folder holding the project files.

How to remove a project from the File=Recent Projects menu and the Start Page in Flare
1. Inthe Flare project, select File>Recent Projects>Manage Recent Projects. The Recent Projects dialog opens.
2. Highlight the project and click Remove.

3. Click OK.
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WEBWORKS EPUBLISHER



WebWorks ePublisher in a nutshell

® Converts content from three
possible source formats:

« FrameMaker
- Word
- DITA

® No editor of its own

" Separate products for design,
production, and power production

" Large range of output types



WebWorks ePublisher workflow

Wo rd

Eclipse
Help

'@‘“@

Also:

e HTML

» JavaHelp

* MS Reader
 Palm Reader
« WinHelp...




WebWorks ePublisher Ul and usability
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WebWorks ePublisher Ul and usability

" Designer product (ePublisher Pro) is
complex and requires some
technical expertise

" Production product (ePublisher
Express) very simple to use



WebWorks ePublisher key strengths

" User-generated content
(wiki and Reverb outputs)

" Simple HTML output

" Stationery makes for very straight-
forward production



WebWorks ePublisher key weaknesses

" WebHelp output

® No TOC editor
® Documentation / user assistance



WebWorks ePublisher’s own Help

webworks.com

r B Q G @ »

Selecting Input and Output Formats b9 Designing, Deploying, and Managing Stationery : Designing Stationery : Organizing and Managing Styles
—
Designing Input Format Standards > W Tweet |- E L= =
Designing, Deploying, and Managing v . .
Stationery Organizing and Managing Styles
cope - In Style Designer, you can organize your styles in a hierarchy and then use inherited properties to reduce design and maintenance time. You can
gr;f;(#::'y Design. Deploy. and Manage create a hierarchy of similar styles, set the style property values once, and have those values inherited by child styles.
The Prototype style, which is essentially the parent style for all styles, allows you to quickly define properties for all styles. This style allows you to
Understanding Stationery > make global changes across all styles that inherit properties from the Prototype style. For example, vou may have all styles inherit their font and
vertical spacing from the Prototype style.
Designing Stationery i Mote: Child styles inherit only property values from a parent style. Child styles do not inherit additional features specified on the Options tab.
Creating a Stationery Design Project By default, all style properties of a parent style are inherited by its child styles. If you change the property values of a parent style, those changes are
inherited by the child styles of that parent style. You can override specific properties for a child style to make those not inherited from its parent style.
Adding Qutput Formats to Your o Once the value of a specific property is set at the child level, changes you make to the parent style for that property do not affect the child style.
Stationery Design Project To organize styles in Style Designer
Updating a Project ta Include All Styles 1. Open your Stationery design project.

On the View menu, click Style Designer.

Understanding Style Designer >

2.
3. Click the type of styles you want to organize, such as Paragraph Styles.
Organizing and Managing Styles . .
9 g ging Sty 4, If you want to make a style the child of another style, drag and drop the child style on top of the style you want to make its parent

Previewing the Qutput from a Source File style.
5. Click on the child style and review the properties for that style to make sure it inherits the property values you want from its parent style.
Defining New Pages (Page Breaks)

Defining TOCs and Mini-TOCs > n nm

Modifying the Appearance of >

Paragraphs Add New Comment

Defining the Appearance of Bulleted Lists e e

Defining the Appearance of Numbered Lists £ Twitter I openip PR

Defining the Appearance of Bulleted and
Mumbered Lists for Wiki Markup ‘ Type your comment here.




Server-based Help

" HelpServer by 4.5T
" RoboHelp Server

" MadCap Feedback Server



Final comments

" All of the HATs described in this
presentation are great tools

® Other HATs are available

" Your best choice depends on your
preferred workflow

" Always test drive with real data
before purchasing
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